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TIN HỌC VĂN PHÒNG

PHẦN 1: WINDOWS
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TỔNG QUAN

BÀI 1. 

TỔNG QUAN VỀ MÁY TÍNH
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I. Một số khái niệm cơ bản

 Tin Học (Informatic) là ngành khoa học công nghệ 

nghiên cứu về những thu thập thông tin và xử lý 

thông tin bằng máy tính.

 Thông Tin (Informations) mang lại cho con người 

sự hiểu biết, nhận thức tốt hơn về những đối tượng 

trong đời sống XH, …

 Máy tính: là thiết bị làm bằng các vi mạch điện tử 

để xử lý tự động thông tin theo một quá trình được 

ấn định trước.

4

I. Một số khái niệm cơ bản (tt)

 Chƣơng trình (Program): là tập hợp nhiều 
câu lệnh phối kết hợp với nhau một cách logic 
để xử lý tự động.

 Phần mềm (Software): là các chương trình 
được cài vào để máy tính thực hiện được các 
công việc đa dạng theo yêu cầu của người sử 
dụng.

 Máy vi tính chia làm 2 phần: phần cứng và 
phần mềm
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II. Các bộ phận của máy tính

1. Phần cứng (hardware)

 Phần cứng: là toàn bộ những linh kiện để tạo 
thành một máy tính. Gồm có : 

* a. Bộ xử lý trung tâm (CPU – Control 
Processing Unit): là cơ quan đầu não của máy tính 
điều khiển toàn bộ hoạt động của máy tính kể từ 
khi nhập số liệu, tính toán, lưu trữ cho đến khi in ra 
kết quả. Có 2 bộ phận chính như sau: 

- Khối tính toán số học và logic (ALU –Arthmetic 
Logic Unit)

- Khối điều khiển : (CU – Control Unit)
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II. Các bộ phận của máy tính (tt)

1. Phần cứng (hardware)

b. Thiết bị lƣu trữ : là nơi chứa chương trình và dữ liệu 
(Data) trong quá trình máy tính xử lý thông tin, gồm có 2 
loại:

- Bộ nhớ trong:  gồm có 2 loại:

+ ROM (Read Only Memory): là bộ nhớ chỉ đọc dùng để 
chứa các chương trình hệ thống mà người sử dụng không 
thể can thiệp được. ROM do nhà sản xuất ghi vào. Khi mất 
điện các chương trình trong ROM vẫn còn .

+ RAM: (Random Access Memory): là bộ nhớ truy cập 
ngẫu nhiên, ta có thể ghi, xoá thông tin trong lúc làm việc, 
khi mất điện các thông tin sẽ bị xoá hết.
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II. Các bộ phận của máy tính (tt)

1. Phần cứng (hardware)

c. Bộ nhớ ngoài : 

Khi lượng thông tin cần xử lý vượt quá dung 

lượng của bộ nhớ chính thì máy tính dùng đến bộ 

nhớ phụ

Vd: đĩa từ, băng từ , …
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II. Các bộ phận của máy tính (tt)

1. Phần cứng (hardware)

d. Một số loại đĩa (Drive) :

- Đĩa mềm: Ký hiệu là FDD – thường gọi là đĩa A, có 

dung lượng nhỏ, tốc độ đọc, ghi dữ liệu chậm.

- Đĩa cứng: Ký hiệu là HDD  - có dung lượng lớn, tốc 

độ đọc, ghi nhanh, trong máy tính người ta thường 

phân thành đĩa C,D,E, … (tùy theo người sử dụng cài 

đặt).

- Đĩa CDROM: là đĩa chỉ đọc không cho phép thêm, 

xoá, sửa dữ liệu trên đó.

- Đĩa USB: sử dụng cổng USB .  
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II. Các bộ phận của máy tính (tt)

1. Phần cứng (hardware)

e. Các thiết bị ngoại vi: là những bộ phận giúp trao 

đổi thông tin giữa CPU - bộ nhớ trong và môi 

trường bên ngoài. 

+ Thiết bị nhập:

- Bàn phím (Keyboard): là thiết bị nhập chuẩn, 

dùng để nhập dữ liệu từ bên ngoài vào máy tính . 

- Chuột (Mouse): Là thiết bị điều khiển con trỏ 

trên màn hình.
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II. Các bộ phận của máy tính (tt)

1. Phần cứng (hardware)

- Máy quét (Scanner) là thiết bị nhập dùng để 

nhập liệu vào máy tính dưới dạng hình ảnh hay 

văn bản.

+ Thiết bị xuất:

- Màn hình (Monitor) là thiết bị dùng để hiển thị 

giao tiếp giữa người và máy

- Máy in ( Printer) là thiết bị xuất dùng để xuất 

dữ liệu từ máy tính ra ngoài giấy. Hiện nay máy 

in thường có 3 loại : in kim, in phun, in lazer
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II. Các bộ phận của máy tính (tt)

2. Phần mềm (Soft ware) 

 1/ Phần mềm hệ thống: là những chương trình khởi động 
máy, điều khiển thiết bị và tạo môi trường để người sử 
dụng máy tính tiện lợi và có hiệu quả,… như: Hệ điều hành 
WINDOWS, LINUX,... 

 2/ Phần mềm ứng dụng: gồm 2 loại 

 a) Chương trình dịch: là chương trình dùng một loại ngôn 
ngữ nào đó để viết lệnh gọi là Ngôn Ngữ  Lập Trình (Ví 
dụ: Pascal, C, C++, Java, … )

 b) Chương trình ứng dụng: là những chương trình được 
các lập trình viên viết sẳn và người dùng chỉ việc sử dụng 
(Ví dụ:Word, Excel,  phần mềm kế toán,…)
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III. Đơn vị thông tin:

 bit: là đơn vị cơ sở thông tin, ngoài ra còn có các 

đơn vị khác như :

 + Kilobit (Kb) = 2    bit = 1024 bit

 + Megabit (Mb) = 2    Kb

 + Gigabit (Gb) = 2    Mb

 + Byte (B) = 8 bit

10
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TỔNG QUAN

BÀI 2. CÁC KHÁI NIỆM 

VỀ HỆ ĐIỀU HÀNH

14

I. Hệ điều hành ( Operating System):

 1 / Khái niệm “Hệ điều hành”

- Là tập hợp các chương trình.

- Là cầu nối giữa người và máy tính giúp cho việc 

sử dụng máy tính thuận tiện và có hiệu quả. 

- Ngoài ra còn có tác dụng điều khiển toàn bộ 

hoạt động của máy tính. 
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I. Hệ điều hành ( Operating System) (tt)

 2/ Chức năng

- Quản lý phân phối và thu hồi bộ nhớ

- Điều khiển việc thực thi các chương trình 

- Điều khiển các thiết bị ngoại vi.

- Quản lý các tập tin và thư mục.

 Hiện nay hệ điều hành được sử dụng nhiều nhất 

là hệ điều hành Windows . Ngoài ra còn có các 

hệ điều hành như: Linux , Unit , Solaric, …
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II. Quá trình khởi động máy tính : 

 1/ Khởi động bằng đĩa cứng :

- Lấy đĩa CDROM ra khỏi ổ đĩa 

- Nhấn nút Power trên máy tính và đợi một 

khoảng thời gian cho đến khi máy khởi động 

xong
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II. Quá trình khởi động máy tính (tt) 

 3/ Khởi động lại:

a) Khởi động nguội: Sử dụng công tắc Power

trên máy tính

b) Khởi động nóng: (trường hợp máy tính bị 

treo)

+ Nhấn nút Reset trên máy tính

+ Nhấn tổ hợp phím Ctrl+Alt+Delete trên bàn 

phím
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III. Quá trình tắt máy: 

 Đóng toàn bộ chương trình ứng dụng đang 

chạy trên máy 

 Lấy đĩa CDROM (nếu có) ra khỏi ổ đĩa

 Trên hệ điều hành Windows XP ta thực hiện 

như sau: Start → Turn Off Computer →

Turn Off 
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III. Quá trình tắt máy (tt) 

Lƣu ý:

 Để đảm bảo an toàn cho máy tính giữa 2 

lần khởi động phải cách nhau ít nhất 15 

giây

 Ta không nên tắt mở máy thường xuyên, 

vì thế sẽ làm giảm tuổi thọ của máy.
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IV. Cấu trúc bàn phím (Keyboard): 

 Bàn phím thường hay sử dụng hiện nay là 104 

/105 phím, ngoài ra còn có các loại bàn phím 

mới hỗ trợ các tiện ích về Multimedia (như 

chỉnh nhạc, truy cập nhanh Internet, …)

 CẤU TRÚC BÀN PHÍM: chia làm 3 vùng

+ Vùng phím kí tự 

+ Vùng phím số 

+ Vùng phím điều khiển 
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IV. Cấu trúc bàn phím (Keyboard) (tt) 

1/ Vùng phím kí tự

Là vùng phím nằm bên trái bàn phím .

 Các phím ký tự  từ A → Z, các số từ 0 → 9, các 

dấu, các ký hiệu đặc biệt , …

 Các phím từ F1 - F12 (Function):l à các phím 

chức năng tuỳ theo trình ứng dụng mà có ý 

nghĩa khác nhau .

 ESC (Escape): dùng để huỷ bỏ một thao tác 

đang thực hịên hay đang xử lý
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IV. Cấu trúc bàn phím (Keyboard) (tt) 

1/ Vùng phím kí tự

 Phím Tab : dùng để chuyển điểm nháy (con trỏ) 

đến vị trí nhất định được ấn định trên màn hình

 Phím CapsLock: khi nhấn phím đèn Capslock 

sáng cho ta nhập chữ hoa, khi ta nhấn lần nữa đèn 

Capslock sẽ tắt cho ta nhập chữ thường 

 Phím Shift: Shift + kí tự thường → ký tự  HOA

và ngược lại

 Shift kết hợp với phím có 2 ký tự cho ta sử dụng 

ký tự phía trên được ghi trên phím
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IV. Cấu trúc bàn phím (Keyboard) (tt) 

1/ Vùng phím kí tự

 Phím Ctrl, Alt :là phím kích hoạt thường kết 

hợp với các phím khác khi xử lý

 Ví dụ :  Alt+ F4: đóng cửa sổ hiện hành

Ctrl+C: Copy(sao chép vào vùng nhớ)

Ctrl+S: lưu bài

 Phím Spacebar: dùng để tạo ra một khoảng kí 

tự trắng khi gõ phím 
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IV. Cấu trúc bàn phím (Keyboard) (tt) 

1/ Vùng phím kí tự

 Phím Enter: xuống dòng trong soạn thảo văn 

bản hoặc thực thi một yêu cầu nào đó

 Back Space (← ): dùng để xoá ký tự bên trái 

của điểm nháy

 Delete: dùng để xoá ký tự bên phải điểm nháy.
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IV. Cấu trúc bàn phím (Keyboard) (tt) 

2/ Vùng phím số: 

Là vùng phím nằm bên phải bàn phím

 Khi nhấn phím đèn NumLock bật sáng cho 

phép ta được dùng phím số bên vùng phím bên 

phải

 Khi nhấn phím lần nữa đèn NumLock tắt cấm 

sử dụng các số bên phải mà cho ta sử dụng chức 

năng thứ hai được ghi trên phím. 

 Các phép toán: + , - , * , /, .
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IV. Cấu trúc bàn phím (Keyboard) (tt) 

3/ Vùng phím điều khiển 

Là vùng phím nằm giữa vùng phím ký tự và 

vùng phím số

 Print Screen: dùng để chép nội dung đang thể 

hiện trên màn hình đưa vào bộ nhớ máy tính

 Pause / Break : tạm ngưng tiến trình đang thể 

hiện trên màn hình, khi nhấn một phím bất kỳ 

chương trình sẽ hoạt động tiếp tục  

 Insert: dùng chuyển đổi qua lại giữa 2 chế độ gõ 

chèn và gõ đè
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IV. Cấu trúc bàn phím (Keyboard) (tt) 

3/ Vùng phím điều khiển 

 Home: chuyển dấu nháy về đầu dòng văn bản

 End: chuyển dấu nháy về cuối dòng văn bản

 Page Up: cuộn lên một trang màn hình

 Page Down: cuộn xuống một trang màn hình

 Up (↑): lên một dòng

 Down (↓): xuống một dòng

 Left (←): qua trái một kí tự

 Right (→): qua phải một kí tự
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V. Cách sử dụng chuột (Mouse):

 Nhấp Chuột (Click): nhấp nút trái chuột 1 lần 

(thường dùng để chọn đối tượng)

 Nhấp đôi – nhấp đúp (Double Click): nhấp 

nhanh nút trái chuột 2 lần liên tiếp (thường dùng 

để thực thi một đối tượng)

 Nhấp phải (Right Click): nhấp vào nút chuột 

bên phải 1 lần (thường dùng để kích hoạt menu 

tắt)  
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V. Cách sử dụng chuột (Mouse) (tt)

 Di chuyển (Move): lướt nhẹ chuột trên mặt bàn 

sao cho trỏ chuột trên màn hình di chuyển đến vị 

trí thích hợp .

 Rê chuột (Drog Drag): nhấn và giữ chuột đồng 

thời kéo chuột đến vị trí mới nhả chuột ra .

30

Windows

BÀI 3.

MÔI TRƢỜNG WINDOWS
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I. Khái niệm 

 Windows là một chương trình được xem 

như một Hệ Điều Hành, cung cấp cho 

người sử dụng những thuận lợi, tiện nghi 

cho việc giao tiếp giữa người và máy tính 

được dễ dàng và nhanh chóng.
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I. Khái niệm (tt)

 1. Tập tin: (File): là đơn vị quản lý dữ liệu của 

đĩa

- Tên tập tin: gồm 2 phần: Tên và kiểu (phần 

mở rộng, đuôi)

VD: thongbao.doc, baitho.txt

 2. Thƣ mục: (Folder)

Là đơn vị chứa tập tin và thư mục nhỏ hơn 

VD: DULIEU, CHUONG_TRINH
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II. Khởi động và Giới thiệu màn hình 

Windows:

 1. Khởi động: Nhấn nút POWER trên 

CPU

 Giới thiệu màn hình Windows:

- Nền (Destop)

- Thanh tác vụ (Taskbar)

- Các biểu tượng thư mục (Folder)

- Các biểu tượng tập tin (File)
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III. Các thao tác dùng chuột

 Trái chuột:

* Nhấn 1 cái (click): chọn biểu tượng

* Nhấn 2 cái liên tục (double click): mở 

biểu tượng

* Nhấn kéo (drag): di chuyển biểu tượng

 Phải chuột: mở menu lệnh chứa các công 

cụ
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IV. Thay đổi khung nền

 Right_click vào vùng trống trên màn hình

- Chọn  Properties → hộp thoại xuất hiện

 Chọn thẻ Desktop

 Chọn hình nền Trong Background →

Apply → Ok

36

V. Chế độ bảo vệ màn hình

 Right_click vào vùng trống trên màn hình 

- Chọn Properties → hộp thoại xuất hiện

 Chọn thẻ Screen Saver

 Chọn hình bảo vệ Trong Screen Saver →

Apply → Ok

 Wait: là thời gian chờ bắt đầu bảo vệ màn 

hình khi không sử dụng máy
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VI. Cài đặt chế độ phân giải 

 Right_click vào vùng trống trên màn hình 

- Chọn Properties → hộp thoại xuất hiện

 Chọn thẻ Settings

 Chọn độ phân giải Screen Resolution

(800x600) 

 Chọn độ nét của màu Color Quality

(Highest (32bit))

38

VII. Thoát khỏi Windows và tắt máy 

 Chọn Start → Shut Down:

* Restart: khởi động lại máy

* Shut down: tắt máy

* Log off: thoát khỏi user đang sử dụng
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Windows

BÀI 4. CHƢƠNG TRÌNH 

WINDOWS EXPLORER

40

 Các chương trình và dữ liệu của bạn được 
lưu thành các tập tin (Files) trên các thiết 
bị như: Ổ đĩa cứng; đĩa USB; đĩa CD ghi 
được (Rewriteable); ổ đĩa mạng...

 Trong phần này, bạn sẽ học cách dùng 
Windows Explorer để quản lý tập tin và 
thư mục.

I. Tổng quan
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 Click phải chuột trên nút Start và click 

mục Explorer để mở Windows Explorer.

 Khung trái chứa tên

các ổ đĩa và các thư mục

Khung bên phải chứa 

nội dung các file và

thư mục

II. Mở Windows Explorer

II. Mở Windows Explorer (tt)

 Khung trái 

chứa tên các 

ổ đĩa và các 

thư mục     

Khung bên 

phải chứa nội 

dung các file 

và thư mục

42
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 Thay đổi hình thức hiển thị trên khung phải:

Click chọn menu View và chọn một trong 5 hình 
thức hiển thị:

1. Thumbnails: thường dùng để xem trước các 
File hình.

2. Tiles: Hiện các tập tin và các thư mục con ở 
dạng biểu tượng lớn

3. Icons: Hiện các tập tin và các thư mục con ở 
dạng biểu tượng nhỏ

III. Cửa sổ Windows Explorer

44

4. List: Hiện các tập tin và các thư mục con ở 

dạng liệt kê danh sách.

5. Details: Liệt kê chi tiết các thông tin như 

tên (Name), kiểu (Type), kích thước lưu 

trữ (Size), ngày giờ tạo hay sửa 

(Modified).

III. Cửa sổ Windows Explorer (tt)
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 Click chọn hay

bỏ chọn nút 

Folders trên

thanh công cụ 

chuẩn 

IV. Hiện/ẩn cây thƣ mục trên khung 

trái:

46

 Click chọn View\Arrange Icons by và 

chọn thứ tự sắp xếp

 Theo tên : Name

 Theo kích thước : Size

 Theo phần mở rộng : Type

 Theo Ngày tháng tạo sửa : Modified

V. Sắp xếp dữ liệu bên khung phải
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 Tạo một thƣ mục:

1. Mở thư mục muốn tạo thêm thư mục con

2. Chọn menu File \ New \ Folder

hay click chuột phải vào vùng trống bên khung 

trái chọn New \ Folder. Một thư mục mới hiển 

thị với tên mặc định là New Folder.

3. Gõ tên thư mục mới (nếu muốn) và ấn phím 

Enter hay nhấn chuột ra khỏi thư mục mới tạo.

VI. Quản lý thƣ mục và tập tin

48

 Khái niệm Shortcut:

- Shortcut là một file liên kết đến một đối tượng 

trên máy tính hay trên mạng. Đối tượng đó có 

thể là tập tin, thư mục, ổ đĩa, máy in hay máy 

tính khác trên mạng. 

- Shortcut là cách nhanh nhất để khởi động một 

chương trình được sử dụng thường xuyên hoặc 

để mở tập tin, thư mục mà không cần phải tìm 

đến nơi lưu trữ chúng.

VI. Quản lý thƣ mục và tập tin (tt)
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 Tạo Shortcut:

1. Mở thư mục chứa tập tin chương trình cần tạo 

Shortcut

2. Click chuột phải vào tập tin/thư mục cần tạo 

shortcut

3. Chọn Create Shortcut: nếu tạo Shortcut ngay 

trong thư mục đang mở,

4. Chọn Send to\Desktop(create shortcut): nếu 

muốn tạo Shortcut trên nền Desktop.

VI. Quản lý thƣ mục và tập tin (tt)
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 Đổi tên tập tin hay thƣ mục (Rename):

1. Mở ổ đĩa hay thư mục chứa tập tin hoặc thư 
mục con cần đổi tên

2. Click vào tên tập tin hay thư mục muốn đổi 
tên

3. Chọn menu File\ Rename hay Click chuột 
phải vào file/thƣ mục chọn Rename bên khung 
trái

4. Gõ tên mới, sau đó ấn phím Enter.

VI. Quản lý thƣ mục và tập tin (tt)
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 Di chuyển một tập tin hay thƣ mục (Move):

1. Mở ổ đĩa, thư mục chứa tập tin hay thư mục con 

cần di chuyển

2. Click vào tên tập tin hay thư mục muốn di chuyển

3. Chọn menu Edit\Move To Folder… Hộp thoại 

Move Items xuất hiện

4. Trong hộp thoại này, click chọn ổ đĩa, thư mục 

muốn chuyển đến, sau đó click nút Move

VI. Quản lý thƣ mục và tập tin (tt)
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 Sao chép một tập tin hay thƣ mục (Copy):

1. Mở ổ đĩa hay thư mục chứa tập tin hay thư mục 

con cần sao chép

2. Click vào tên tập tin hay thư mục muốn sao chép

3. Chọn menu Edit →Copy hay Ctrl + C

4. Chọn thư mục muốn sao chép qua

4. Edit → Paste hay Ctrl + V.

VI. Quản lý thƣ mục và tập tin (tt)
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 Đặt thuộc tính cho tập tin:

1.Chọn đối tượng

2. Vào File → Properties

+ Read only: chỉ đọc

+ Hidden: ẩn

+ Archive: lưu file

+ System: hệ thống

VI. Quản lý thƣ mục và tập tin (tt)
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 Xóa tập tin hay thƣ mục:

- Khi xóa tập tin hay thư mục trong đĩa cứng, Windows sẽ 

di chuyển tập tin hay thư mục đó vào Recycle Bin. Đây là 

thư mục của Windows dùng chứa các file bị xóa. Bạn có thể 

mở thư mục này để phục hồi lại hoặc xóa hẳn khỏi đĩa cứng.

- Nếu xóa dữ liệu trên đĩa USB hay đĩa CD ghi được thì 

không được chuyển vào Recycle Bin.

- Nếu dữ liệu nằm trên ổ đĩa mạng thì Windows có thể 

chuyển vào Recycle Bin hay xóa đi tùy thuộc vào sự cài đặt 

của người quản trị mạng.

VI. Quản lý thƣ mục và tập tin (tt)
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 Xóa tập tin hay thƣ mục:

1. Chọn tập tin hay thư mục cần xóa

2. Chọn menu File → Delete hay chọn phím 

Delete

3. Windows Explorer sẽ hiển thị hộp thoại xác 

nhận xóa. Click nút Yes để thực hiện; hoặc click 

No nếu không.

VI. Quản lý thƣ mục và tập tin (tt)
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 Xóa tập tin hay thƣ mục:

Chú ý:

* Bạn có thể Click chuột phải vào đối tượng cần 
xóa và chọn mục Delete

* Với cách xóa này bạn có thể phục hồi lại ngay 
bằng cách Click chuột phải vào vùng trống bên 
khung phải và chọn mục Undo Delete.

* Để xóa vĩnh viễn tập tin hay thư mục, bạn giữ 
phím Shift + Delete…

VI. Quản lý thƣ mục và tập tin (tt)
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VII. Tìm kiếm tập tin hay thƣ mục (Search)

1. Click nút Search trên thanh công cụ.

2. Click mục All files and folders

3. Nếu muốn tìm theo tên file hay thư mục, hãy gõ 
vào đầy đủ hay một phần của tên file trong hộp All 
or part of file name

4. Hoặc nếu muốn tìm trong nội dung file gõ vào một 
từ hay một cụm từ đại diện cần tìm trong hộp A 
word or phrase in the file.

5. Bạn có thể chỉ ra nơi cần tìm vào bằng cách click 
vào hộp Look in, sau đó chọn ổ đĩa hay thư mục

6. Click nút Search.

58

VII. Tìm kiếm tập tin hay 

thƣ mục (Search) (tt)
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 Hiển thị danh sách ổ đĩa:

1. Chọn My Computer bên khung trái.

2. Để xem dung lượng và kích thước còn trống 

trên đĩa: Click mục View\Details 

hoặc

- Click chuột phải vào ổ đĩa cần xem sau đó 

chọn Properties

VIII. Quản lý đĩa với My Computer
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VIII. Quản lý đĩa với My Computer (tt)



31

61

 Control Panel là một chương trình thiết lập 

lại cấu hình hệ thống , thay đổi hình thức 

của Windows nhằm thay đổi môi trường làm 

việc cho thích hợp với người sử dụng.

 Khởi động:

Click nút Start và chọn mục Control Panel

IX.Control Panel

62

IX.Control Panel (tt)
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 Để thay đổi cách biểu diễn ngày, giờ, số, tiền tệ 

trong các chương trình chạy trên Windows. Bạn 

cần thực hiện các bước sau:

1. Khởi động Control Panel

2. Bấm đúp vào biểu tượng Regional and 

Language Options trên cửa sổ Control Panel

3. Trên trang Regional Options, click nút 

Customize

9.1 Thay đổi cách biểu diễn Ngày, Giờ,

Số, Tiền tệ

64

4. Thay đổi dạng thức số (Numbers); Tiền tệ 

(Currency); Giờ (Time); Ngày (Date) trên 

hộp thoại Customize Regional Options, 

Click OK

5. Click nút OK trên hộp thoại Regional and 

Language Options để ghi nhận các thay đổi.

9.1 Thay đổi cách biểu diễn Ngày, Giờ,

Số, Tiền tệ (tt)
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 Fonts được dùng để hiển thị văn bản trên 

màn hình hoặc máy in.

 Ta có thể xóa bỏ những Font không cần sử 

dụng hoặc cài đặt thêm những Font mới.

 Mở trình quản lý Fonts:

Bấm đúp vào biểu tượng Fonts trên cửa sổ 

Control Panel

9.2 Quản lý Fonts chữ :
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 Thêm Font :

1. Chọn menu File

2. Chọn mục Install New Font...

3. Chọn ổ đĩa chứa Font trong hộp Drives

4. Chọn thƣ mục chứa Font trong khung Folders

5. Chọn Font trong List of Fonts

6. Click nút OK

9.2 Quản lý Fonts chữ : (tt)



34

67

 Thêm Font :

9.2 Quản lý Fonts chữ (tt)
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 Destop mặc định rất đơn giản, bạn có thể 
thay đổi màu nền, hình nền hoặc các thành 
phần khác theo ý thích của bạn.

 Khởi động trình quản lý màn hình:

+ Bấm đúp vào biểu tượng Display trên cửa 
sổ Control Panel

+ hay click chuột phải lên màn hình Destop 
→ chọn Properties

9.3 Thay đổi màn hình Destop:
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 1. Trong hộp thoại Display Properties, chọn 

tab Themes

 2. Click mũi tên hướng xuống trong danh 

sách Theme, chọn một kiểu bất kỳ mà bạn 

muốn

 3. Click nút Apply hoặc OK

9.4 Thay đổi kiểu dáng của cửa sổ:
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 1. Trong hộp thoại Display Properties, chọn Tab 
Destop

 2. Trong danh sách Background, chọn ảnh nền 
mà bạn thích.

 3. Trong Position, Click mũi tên hướng xuống 
chọn Center, Tile hay Strech để định vị hình trên 
Destop.

 4. Click nút Apply hoặc OK

 Chú thích: Bạn cũng có thể chọn một ảnh nền 
khác trong thư mục nào đó trên ổ đĩa, bằng cách 
click nút Browse

9.5 Thay đổi ảnh nền của Destop:
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 1. Trong hộp thoại Display Properties, chọn Tab 
Screen Saver

 2. Click mũi tên hướng xuống trong danh sách 
Screen saver, chọn chương trình bạn thích. Click 
Preview để xem trước Screen saver này.

 3. Trong hộp Wait, định thời gian xuất hiện 
Screen saver.

 4. Click nút Apply hoặc OK

 Chú thích: Bạn có thể mua các Screen saver khác 
hoặc tải xuống miễn phí trên Web.

9.6 Thiết lập chƣơng trình bảo vệ 

màn hình
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 1. Bấm đúp vào biểu tượng Date and Time

trên cửa sổ Control Panel

 2. Thay đổi ngày (Date) và Giờ (Time)

trong hộp thoại Date and Time Properties

 3. Trong tab Time Zone cho phép chọn múi 

giờ

 4. Click nút Apply hoặc OK để ghi nhận.

9.7 Điều chỉnh ngày giờ của máy tính
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Thực hành

 Tạo thư mục mới:

Trên ổ đĩa (D:), tạo các thư mục dưới đây:

- Tại thư mục gốc, tạo thư mục TÊNBẠN

- Trong thư mục TÊNBẠN, tạo 2 thư mục SOFT 

và PRG

- Trong thư mục PRG, tạo 3 thư mục ONLINE, 

GAMES và BOOKS

- Trong thư mục SOFT, tạo 2 thư mục OFFICE và 

MULTIMEDIA. 
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Thực hành

 Tạo thư mục mới theo cấu trúc sau (trong ổ D):
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Thực hành

 Sao chép và đổi tên thư mục theo yêu cầu sau:

Yêu cầu:

Sao chép thư mục XA_HOI vào thư mục BAI_TAP.

Sao chép thư mục TRO_CHOI vào thư mục BAI_TAP.

Trong thư mục BAI_TAP, đổi tên thư mục XA_HOI 

thành VAN_HOC.

Trong thư mục BAI_TAP, đổi tên thư mục TRO_CHOI 

thành GIAI_TRI.
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Thực hành

 Di chuyển, xóa và đặt thuộc tính thư mục theo yêu cầu sau:

Yêu cầu:

Tại thư mục BAI_HOC, chuyển thư mục CHINH_TRI

đến thư mục BAI_TAP.

Di chuyển các thư mục trong thư mục BAI_HOC đến thư

mục THUC_HANH.

Xóa thư mục TRO_CHOI trong thư mục THUC_HANH.

Xóa thư mục BAI_HOC trong thư mục THUC_HANH.

Trong thư mục BAI_TAP, đặt thuộc tính chỉ đọc cho thư

mục GIAI_TRI.

Trong thư mục THUC_HANH, đặt thuộc tính ẩn cho thư

mục BAI_TAP.
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- HẾT -


